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PREFACE

his book is all about how to rid your Macintosh of

the dreaded disease known as Disk Bloat. If you're
like most Macintosh users, your hard disk somehow
never seems to have enough space on it. You have
probably become so accustomed to seeing the fa-
mous Not Enough Disk Space dialog that you've actu-
ally considered inviting it over for lunch. Just last
week, you needed to put a full-color scan of your Aunt
Tillie on your disk so she'd see her face on your com-
puter and increase your portion of her estate, but
there wasn't enough room, which made her mad. Now
you're not even in her stupid will.

Life with an overcrowded, bleated hard disk is tough.
And as multimedia becomes more and more a part of
your life, as the Information Superhighway keeps drop-
ping tantalizing little files into your download direc-
tory, as applications become suites that eat up more
hard disk space than your first computer had altogeth-
er, the situation is just going to keep getting worse.

It is clearly time to take up arms against this problem
and to stop it before it multiplies. That's what this
book is about.

But like any weight-loss program, you won't follow it if
it's too strenuous or demanding. So I've carved the
process of getting control of your hard drive into a cou-
ple dozen easy exercises, each of which will take only a
few minutes of your time but will result in some gain.
You'll either gain back some hard-fought disk real estate
or get some insight into how it gets so bloated to start
with, so you can act to prevent it from happening again.
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WHAT ARE WE TRYING TO SAVE?

It seems appropriate at the beginning of our workout
together to make sure that we're talking about the
same thing. This book is not primarily about how to
get more memory into your Macintosh. Memory (called
RAM, which stands for random access memory and is
as arcane a term as you're likely to encounter in this
business) certainly gets crowded. But short of adding
more hardware to your computer, there’s a limit to
what you can do to expand the capacity of your com-
puter. (I'll have a few suggestions in Chapter 4, though.)

What we're really going to focus on is your disk drive.
You can think of memory as the place where your
computer thinks and of the disk drive as the place
where it keeps the stuff it thinks about. When you
turn off your Macintosh, its memory is entirely
erased. But information stored on the disk drive stays
there until you remove it—which in the case of many
Macintosh owners borders on never. And that's why |
decided to write this book.

All of this is made a little confusing by the fact that
when you run a program to edit a letter to your boss,
for example, your Macintosh copies some of the stuff
that's on your hard disk (where it's more or less per-
manent, remember) to its memory (where it exists
only as long as it needs to and never survives a sys-
tem shutdown). So there are actually two copies of
that letter: one on the disk and one in your com-
puter's memory. When you save the document, you in
effect tell your Macintosh, “Put a copy of this letter,
which is now in your memory, on the hard disk, where
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it is safe. Then erase the old copy of the letter.” (Actu-
ally, sometimes you don't even erase the old copy, as
you'll see in Chapter 3.)

So our primary focus is on saving disk space, although
we'll have a few exercises designed to give you a little
more elbow room in RAM. (Maybe we should have
called it Elbow RAM, but there are limits to what my
editors will let me get away with here!)

Now that we know what we're going to be exercising
and making more fit, how will we know how much
progress we make? What's the measurement? Pounds,
ounces, inches we understand. Even centimeters and
meters make some sense to some of us. But what is it
that disks have to lose?

Megabytes. (No, that doesn't mean taking a huge
chomp out of your favorite chocolate chip cockie.)
Megabytes are sometimes abbreviated MB. So what's
a megabyte, and what does it mean to free up one of
these little suckers on your hard disk?

Let’s start with the idea that your computer stores
everything, both in RAM and on disks, as 1s and Os.
You've probably heard that before, but you may not
have understood entirely what it meant. You can
think of this as a kind of code made up of tiny light
switches. If a switch is “on,” the computer sees it as
a |. If a switch is off, the computer thinks of it as a 0.
By combining these 1s and 0s into groups, we can cre-
ate a code that we can trick the computer into thinking
really means something. We tell it, for example, “If you
see the pattern ‘01000001, you should think of that as
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the letter ‘A, and it will politely oblige. (Actually, the
details are a little more complex, but I'm not trying to
make you into a computer scientist here. | couldn’t if |
wanted to, since I'm not one, either!)

Computer people long ago decided, not entirely arbi-
trarily, to group these little 1s and 0s (which they call
bits) into groups of eight (which they call bytes.) It
takes eight bits to make a byte, and it takes one byte
to represent a character or a number.

When you put 1,000 of these bytes together, you get a
lilobyte, abbreviated either K or KB. Actually, a kilobyte,
is 1,024 bytes, for mathematical reasons that only the
terminally curious probably care about at this point.
Are you with me so far? Good. There's just one more
step. If you put 1,000K together, you get—you guessed
it'—a megabyte, or a million bytes. (Again, the number is
actually 1,024,000, for the same mathematical reason.)

So the hard disk on your Macintosh holds a certain
number of megabytes of information. Each megabyte
is 1,024,000 characters (if you'll let me be a little loose
about what we define as a character here). Great. And
you just read in this morning's newspaper that the
national debt is some number of trillions of dollars,
and both of these facts make about the same amount
of sense to you.

Let's think of it this way. A typical double-spaced
page of typing holds about 2,000 characters, give or
take a few dozen. So each megabyte on your Macin-
tosh's hard disk can hold the equivalent of something
like 5,120 pages of text. Now you see why these things
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are so valuable in your computing life and why this
Macintosh System Fitness Plan may turn out to be
one of the best investments you ever made.

WHO CARES IF IT's CROWDED?

Aside from the fact that you might not have space to
store that incredibly important document because
your hard disk is jam-packed, what are the real conse-
quences of running with an overstuffed hard disk? Why,
in other words, should you care about this problem?

For openers, the issue of running out of space when
you want to put a document on your disk may not be as
trivial as it seems. "No big deal,” you might think. “I'll
just remove some of the old stuff cluttering up my disk
and then copy the document again. | don’t need a fit-
ness plan or some kind of magic incantation for that.”
That is, for the most part, true. But what if the file you
are trying to put on your hard disk is being downloaded
from an electronic bulletin board system or an Internet
location? In that case, you get partway through the file
transfer, and the process stops because you're out of
hard disk space. At a minimum, you lose the time (and
money) associated with the abortive file download. At
worst, you might find yourself in a very long session
while the remote service and your computer keep up a
running argument. “Here's some more file,” the remote
system says. “Sorry, | can't take it because | have no
place to put it,” your Macintosh replies somewhat coyly.
“Here's some more file.” And so it goes, the two com-
puters locked in a sticky variation of the intriguingly
named "fatal embrace” that sometimes happens on
poorly designed networks.
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If you are running this kind of download session unat-
tended—in other words, if you're away from the ma-
chine while this is going on—your phone line is tied
up, and the meter is running while all of this is hap-
pening. But quite apart from the issue of just running
out of hard disk space during a file transfer or copy,
there are other potential problems associated with a
bloated hard disk.

Many times when you are working with files on your
hard disk, the system needs some spare room to ac-
commodate a request from you or a program. You
aren't even aware of the need for this allocation. But its
unavailability can make a process impossible to carry
out. For example, some programs either allow you to
have automatic backup copies of files made as you save
documents or need such space as you copy or rename
documents. Let’s say you have a 2.5MB color graphic of
a comet fragment crashing into the surface of Jupiter.
You decide to change the resolution of the graphic and,
conscious of the scarcity of hard disk space, save it
using the same name. The program might well be de-
signed so that it first creates a new document into
which to save your changed version and then, only after
successfully saving the new version, deletes the origi-
nal. In that case, if you don’t have a reasonable amount
of disk space available, you could find yourself in a
Catch-22, unable to save the changed document with-
out first exiting and losing the time it took for your
Macintosh to redraw the modified graphic.

Because of the way your hard disk works, you might
find yourself in a situation in which you need 2.5MB
of space for an operation like the one I just described
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and seem to have it available, but the process still
won't work. This may be a result of disk fragmentation,
a situation in which the available free space on your
hard disk is so broken up into smaller pieces that
there isn't one chunk big enough to perform some
part of an operation. (I'll discuss fragmentation and
defragmentation of your hard disk in Chapter 3.)

One final point is worth noting here. Long-time com-
puter users, regardless of the brand of computer they
know, strongly recommend that you never have more
than 90 percent of your hard disk space occupied.
That means, for example, that if you have an 80MB
hard disk, you would be well advised to keep at least
8MB free at all times. If you see hard disk space drop-
ping below that 10 percent safety margin, it’s time to
clean up. (One of the utilities on a special-order disk
made just for readers of this book, Dr. Dan’s Macintosh
Fitness Plan Disk, monitors disk usage automatically
and lets you know when things are getting marginal.)

WHAT'S IN THIS BOOK?

This book contains five chapters. Each chapter cov-
ers a different aspect of making your Macintosh into
a lean, mean computing machine. Within each chap-
ter are several simple exercises: practical, hands-on
things you can do to rid your Macintosh of Disk
Bloat and make it work more efficiently for you.

Chapter 1 is a kind of warm-up session. Here you'll get
a chance to rummage around in your System Folder to
find out what's there, what kinds of things might be

candidates for later removal, and how to protect your-
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self against possible pitfalls in the fitness plan
scheme. In the process, you'll overcome any barriers
you might have as a result of your fear of the unknown.

Chapter 2 begins the real hands-on stuff. In this chap-
ter's exercises, you'll be tossing things liberally into
the Trash can on your Macintosh's Desktop as you get
rid of documents and files that are unnecessary, dupli-
cated, obsolete, or just plain clutter. You'll also learn a
trick for preventing yourself from tossing something
away two seconds before you need it. (Never did that
in your attic or garage or desk, did you? Naw, not you!)

Chapter 3 moves outside the System Folder and looks
at application and document folders strewn about your
hard disk drive. Exercises in this chapter focus on find-
ing things that the people who publish software think
are way cool but that just occupy space on your hard
drive without really contributing much to your Macin-
tosh’'s well-being.

In Chapter 4, I'll divert a little from the disk space
issue and focus briefly on memory and how to expand
its availability. To some extent, this discussion is still
about disk space, since one of the biggest issues you'll
deal with in this chapter is virtual memory. Virtual
memory has blurred the distinction between RAM and
hard disk space that we spent so much time on at the
beginning of this preface. Having more usable mem-
ory available can reduce the amount of hard disk
space you have to leave available for virtual memory.

Finally, Chapter 5 is our cool-down session; we'll talk
about ways to keep things from getting out of hand in
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the future. The chapter is divided into two main sets
of exercises. The first set outlines strategies for man-
aging your hard disk. The second set discusses some
of the tools you can obtain to help you figure out if
and where you have a problem, and how to prevent
and fix such problems.

The book concludes with one appendix, an invalu-
able listing of the most popular Macintosh programs,
along with their file creator types. You'll find this tool
extremely helpful as you try to identify orphaned and
mysterious documents and files you find in your ex-
ploration of your hard disk.

In each chapter, you'll find three kinds of special ele-
ments besides the running text:

P Exercises, which are hands-on, step-by-step
processes for reducing disk bloat

P Equipment Rules, which are general principles
and techniques that will be used in several
places in the book

P Tips. which are just what they sound like

Exercises and Equipment Rules are numbered consecu-
tively from the start of the book to the finish, rather than
starting over with each chapter. They are listed sep-
arately in the Contents and the Index for easy retrieval.
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AND THEN THERE'S THIS Disk

As you will by now have discovered, there is no disk
firmly attached to the inside back cover of this little
volume. The idea is to keep this book small and af-
fordable so that everyone with a Macintosh will feel
compelled to buy it. (Pretty sneaky, eh? I almost did
not tell you about this, but | figure if you've read this
far, you probably already bought the book anyway.)

| have put together a disk that | immodestly call Dr.

Dan's Macintosh Fitness Plan Disk. There's an order form for
this disk at the back of the book. This disk has on it the
following programs, which | created specifically for you:

P Space Monitor, which keeps an eye on your hard
disk’s available space and alerts you if it drops
to 10 percent of the disk drive's total size or less

P Compacting Machine, which helps you set
up and maintain a process that will automati-
cally compress, archive, alias, and delete little-
used files

P Deinstaller, a program you run before and after
installing any new software so that if you later
want to remove it, you can completely uninstall
it rather than leave vestigial traces of it lying
around on your hard disk

P DupeFinder, which is useful if you're not yet
using System 7.5, so that you can easily identify
duplicate copies of files and dispose of them
appropriately
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I'll also throw onto the disk any neat shareware or free-
ware utilities | run across from time to time that relate
to this issue of keeping your Macintosh lean and fit.

CONTACTING THE AUTHOR

[ love hearing from readers. Whether you want to
praise or criticize, offer suggestions, or ask me to clarify
something that | managed somehow to muddy beyond
recognition, please feel free to contact me. The best
way to get my attention and a fairly immediate answer
is with electronic mail. My preferred address is
dshafer@netcom.com. You can also try me on Com-
puServe (71246,402) or America OnLine (DSHAFER).

I check those services at least once a day, and I try to
answer my e-mail within a day of receiving it. If you
don’t have electronic mail, you can send me what I
affectionately refer to as U.S. Snail Mail at

Dan Shafer, President

The Shafer Group

499 Seaport Ct., Suite 201

Redwood City, CA 94063

Or you can send me a fax at (415) 367-1073.
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CHAPTER 1

INSIDE THE SYSTEM FOLDER

My System Folder is bigger than your System Folder.
The problem is, that isn't necessarily as good as
having a father (or mother or spouse or even a very
good friend) who is bigger than the other person’s
equivalent protector. In fact, having a big System Folder
is a problem. For some of us, it borders on an illness.

When [ started writing this book, | had a system with
two hard disk drives. On one of them, a 210MB unit,
my System Folder occupied 19.2MB. On the other, a
500MB device, the System Folder was 34.9MB. And
I'm one of a handful of people left on Planet Earth
who remembers the days when 20MB was a big disk
drive! The point is that these System Folders were
obviously getting out of hand and needed a System
Fitness Plan. Badly.

But if you crack open your System Folder (scary
though that thought is), you'll probably recognize
something less than 20 percent of the stuff in it as
things you've put there. You'll probably recognize at
least some of the folders, Apple Menu Items, Fonts,
Sounds, Control Panels, Extensions, and other items
that you have consciously put into your System
Folder at various times in your Mac's life.

So where'd the rest of this stuff come from? And,
more to the point, do you really need it? How can you
tell? What happens if you remove something that
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sounds unfamiliar to you and then, three months
later, you find out that without that weird-sounding
file, your monthly budgeting program stubbornly re-
fuses to run at all? It's almost as if someone were
secretly feeding your System Folder little fat pills.

In this chapter, I'll teach you how to rummage around
in your System Folder, identify candidates for the
garbage heap, and avoid shooting yourself in the foot
in the process of slimming down your Macintosh's
equivalent to your back bedroom closet.

A BIRD'S-EYE VIEW OF THE SECRET STASH

Alan Mandler, a world-class user interface designer,
likes to point to the VCR as perhaps the most
poorly designed object with which we come into
daily contact. “Almost all of its controls are hidden
behind a little door,” he points out. “From early
childhood, we are taught not to open such doors on
penalty of death or mental confusion.” So it is with
the System Folder. In my Mac travels, I'm continu-
ally amazed at how many people have never even
opened their System Folders.

So our first exercise is to open this mysterious closet
where all sorts of weird-sounding stuff lives and to
take a quick tour of how it's organized. (This is more
of a warm-up than an exercise, but it's a good place
to begin.)
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e

|

ﬂ ExerRcISE 1—GETTING TO KNOW YOUR
SyYSTEM FOLDER

1. Let’s find out how overweight your System

Folder is. Click on its icon once to highlight it.
Now either press Command-I on the keyboard
or select Get Info from the File menu in the
Finder. A window like the one shown in

Figure 1-1 will appear.

S[E== System Folder Info

Systern Folder

Kind: folder
Size: 19.2 MB on disk (19,415,297
bytes used), for 333 items
Yhere: Spinoza:

Created: Wed, Sep 14, 1994, 3:33 PM
Modified: Tue, Oct 4, 1994, 433 PM
Comments:

Figure 1-1. Finding out how big your system folder is

2. Note that this dialog tells you not only how

many bytes of space your System Folder takes
up on your disk but also how many items are
contained in it.

. After recovering from Info Shock, close the

window.

. Open the System Folder by double-clicking on

its icon. (Even if you are a System 7 user more
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accustomed to turning the little triangular crank
next to the folder, this time open it by double-
clicking on it. This lets you arrange its view the
way you want, independently of how other
things on your hard disk are displayed.)

5. Go to the Finder's View menu and select By
Name, so that the list of applications, folders,
and documents in your System Folder appears
in alphabetical order,

6. If you're using System 7.x, there is at least some
semblance of organization here. You'll probably
find folders named Apple Menu Items, Control
Panels, Extensions, Fonts, and Preferences,
among others. If you are running System 6, go
to the View menu in the Finder and choose By
Kind. This will put all of the objects of the same
type together and make it easier to explore this
folder. Take a minute to explore your System
Folder, getting generally familiar with what's in
it. Open some folders. Select an interesting-
sounding document and choose Get Info from
the File menu. See how many icons you recog-
nize and how many sound totally unfamiliar.
Don't worry if you don't understand some or
most of it. You'll soon feel quite at home here.

Now that you're comfortable moving around in your
System Folder (and have survived your first foray into
its mysterious innards), you're ready to do some pur-
poseful exploration.
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At this point, take to heart the first rule of working
with any computer’s files: Back up everything. For the
moment, if you will just back up your System Folder
to a safe place, you'll give yourself some peace of
mind (since you can always recover from an error, so
you're less afraid to make one) and security. Also, be
sure you have handy a disk from which you can boot
your Macintosh in the event of a mistake that dis-
ables it. | won't tell you to do anything that would
have that result, but you just want to be sure.

NOTE: Take these cautions seriously. They aren’t
here so this book will be longer. Backing up
your data and your system is an important
habit to cultivate. If you aren’t already
doing so, start today!

Let's start with something really easy and safe just to
get our feet wet. When the system software was origi-
nally installed on your Macintosh, Apple created a
number of files for you, including the Scrapbook File.
Apple kindly supplies you with some sample artwork
in this file. Some of this art may even come in handy
someday, but a lot of it is largely useless: empty calo-
ries. Let's get rid of some of this stuff.
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-"leﬂ.f':-F?“ EXERCISE 2—TRIMMING USELESS

‘TIL'

1

SCRAPBOOK FAT

. Select the Scrapbook File icon by clicking on

it once.

. Choose Get Info, using either the keyboard or

the File menu option. Note its size.

. Double-click on the Scrapbook File icon. (If

you're using System 6, open the Scrapbook
from the Apple menu.)

. Examine each item in the Scrapbook File by

scrolling through its contents, using the scroll-
bar at the bottom of the window. If you can’t see
the whole object and you want to see it before
deciding its fate, copy it and then paste it into
your favorite text editor or word processor.

. When you find an item that you can't see having

any real use for (the one shown in Figure 1-2
was one of my favorite candidates for the junk
food pile), just use the Edit menu to cut or clear
it. (The difference is that Clear removes all
traces of the object whereas Cut removes it from
its present location and puts a copy on the Clip-
board. For all practical purposes, though, they're
the same unless you plan to use this object
later, in which case you probably shouldn't
delete it to begin with!)
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Figure 1-2. Scrapbook File item headed for junk food pile

6. After you've eliminated all the useless stuff in
your Scrapbook File (and it's perfectly all right
to remove everything if you like), close it. The
file automatically saves itself.

7. Repeat steps | and 2 and note how much disk
space you've saved. It's probably not much,
but every fitness plan starts with a small step
toward the ultimate goal of creating a lean,
mean machine.

Pretty painless exercise, right? And you gained
back some of your previously occupied disk space in
the process.
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DEEPER INTO THE RECESSES

In preparation for the serious fitness plan we'll em-
bark on in Chapter 2, let’'s produce some printouts
showing what's in some of the folders that are the
most likely candidates for slimming down. This
process is easy, but it may be a little time consuming.
You should undertake it only when you are ready to
work your way through Chapter 2, which will take you
between one and three hours, depending on a host of
variables. If you have to spread the task over several
sessions or days, the folders’ contents could change.

[f you are using System 6, the process will not be as
precise as described in Exercise 3.

”j@ EXERCISE 3—PRINTING SYSTEM
7T FOLDER CONTENTS (SYSTEM 6)

1. Open your System Folder.

2. Make sure you are viewing it by name.
3. From the File menu, choose Print Directory.

4. Repeat the process with any folders contained
in your System Folder, as well as any folders
contained in those folders, and so on, until you
have printed out an alphabetical listing of
everything that is in all of the folders in your
System Folder.
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p

Fa Jﬂl! EXERCISE 3—PRINTING SYSTEM

zr FOLDER CONTENTS (SYSTEM 7.X)

1. Open your System Folder again.

2. Look for folders with the names shown in

Table 1-1.

TABLE 1-1. FOLDERS TO LOOK FOR IN SYSTEM FOLDER

FoLpER NAME NOTES/COMMENTS
Apple Menu Items Things that appear on your
Apple menu

Control Panels

Programs and "applets” that
extend the functionality of your
Macintosh

Control Panels (Disabled)

Control panels that have been
temporarily disabled because they
interfere with something else or are
not in use for some other reason

Extensions

Programs and “applets” that
extend the functionality of your
Macintosh

Extensions (Disabled)

Extensions that have been
temporarily disabled because they
interfere with something else or are
not in use for some other reason

Fonts

Fonts used by all applications

Preferences

Covers a multitude of sins,
including not only true preferences
(files that tell the system how you
like certain things to look or
behave] but also files and items
that installation routines
arbitrarily put here
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3. As you find those folders (and you may not
have all of them in your System Folder, so don't
fret if you don’t find one or more of them), open
each, make sure you are viewing them by name,
and then choose Print Window from the File
menu. (The option is called Print Directory in
System 6, but the result is the same.)

4. If a particular folder has folders within it, open
those in turn, view them by name, and print
them as well.

5. When you're done, close all your windows back
to the way you like your Desktop to look.

There is a quicker way to print out the contents of
your System Folder and of all the folders it contains
if you are using System 7. This shortcut results in a
single printout with all of the contents displayed.
Follow these steps instead of those in Exercise 3:

1. Select the System Folder in the Finder's window
for the Startup disk.

2. While holding down the Command and Option
keys, press the right-arrow key on your Macin-
tosh keyboard. This keyboard shortcut opens all
the folders in a selected folder.

3. Now double-click on the System Folder to open
its own window. The Finder remembers that the
windows are all open and displays them this way.
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4, From the File menu, choose Print Window.
(Note that this printout could take a while.)

FINDING OuT ABOUT SYSTEM FOLDER CONTENTS

The real problem with trying to clean up your System
Folder as we will do in Chapter 2 is figuring out what
in the world a lot of this stuff is. Unless you're un-

usual, you'll probably find a fair number of objects in
your System Folder that have the icon for plain docu-
ments (Figure 1-3) associated with them rather than
an icon that at least gives you a fighting chance to

figure out what they are.

Figure 1-3. Plain document icon

The icon for plain documents is your Macintosh’s way
of shrugging, “I don’t know where this thing came
from or what application knows how to do anything
with it.” When you spot this icon, you know you're
looking at something that is a potential source of
Disk Bloat. Chances are that the application that cre-
ated this document is no longer on your system. If it
were, your Macintosh would know what kind of icon
to give the object.
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NOTE: This general rule about the icon for plain
documents isn't 100 percent reliable. Some
applications, particularly those that aren’t
sold commercially, don’t bother to create
special icons for the documents they
create. In addition, sometimes your
Macintosh “forgets” what documents go
with what applications and must have its
Desktop rebuilt (by rebooting while you
hold down the Option key to restore the
connection),

Under System 7, the matter of unidentified document
icons became a bit more complex, as Apple Computer
defined several other “generic” document icons, like
the one shown in Figure 1-4 for control panels. Double-
clicking on some icons that look like the one in Figure
-4 will launch the application to which the document
is connected, but other times, you'll see the by-now-
all-too-familiar dialog that tells you that your Macin-
tosh doesn't know how to open the document.

Figure 1-4. Generic control panel icon

Ultimately, the only way to be certain that a particu-
lar document is no longer connected to its applica-
tion is to double-click on it. If its owning application
can't be found, your system will present the dialog
shown in Figure 1-5.
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could not be opened, because the
application program that created it could
not be found.

0 The document “AppleScripl Preferences”

]

Figure 1-5. Orphaned-document dialog

NOTE: Under System 7.5, you will actually see a
more meaningful and detailed response in
the form of a dialog from which you can
identify the application you'd like to use
to open the document. The meaning,
though, is the same: Your Macintosh is
confused and needs human intervention
to untangle itself.

Sometimes you will see a perfectly clear, nongeneric
icon on your system but find that its parent applica-
tion can't be located. Not all disconnected
documents display the generic icon.

Often, a file’'s name gives you a pretty clear indication
of the application to which it's connected. Documents
named Word Temp followed by a number, for example,
are clearly Microsoft Word documents. The AppleScript
Preferences file | tried to open in Figure 1-5 obviously
belongs to AppleScript. If all developers were so con-
siderate as to name their files in a way that you could
connect them mentally to the right product, life would
be much simpler. Unfortunately, that's not the case.




INSIDE THE SYSTEM FOLDER

As we'll see in Chapter 2, it's important to identify, if
at all possible, the application connected to a docu-
ment you're not sure you need. If the document’s icon
and name give you no clues and if you just can't re-
member (or, more likely, never knew) the application
yourself, there is one more way to find out.

If you have a copy of ResEdit on your system, you can
use it to determine the creator of a particular docu-
ment in many cases. (If you don't have ResEdit, you
may want to get it, particularly if your system is
plagued with lots of this particular specie of Bloat
Beast. You can obtain it on popular electronic bulletin
board systems in the book ResEdit Complete by Peter
Alley and Carolyn Strange (Addison-Wesley, 1991).

Assuming you have ResEdit, you can find out which
application created a particular document by follow-
ing these steps:

1. Launch ResEdit.
2. If necessary, cancel the opening dialog.
3. From the File menu, choose Get File/Folder Info.

4. Navigate to the document you want to analyze
and choose it.

5. The resulting dialog looks like the one in
Figure 1-6. Note the entry labeled Creator. All
Macintosh applications are supposed to have a
unique four-character creator code that they
associate with the documents they create and
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understand. In theory, at least, these codes are
registered by the developer with Apple Com-
puter, Inc., to ensure that they aren't dupli-
cated. In practice, this isn't always the case.
Sometimes the code is sufficiently well chosen
so that it tells you which program created a
document without any further effort on your
part. If the code doesn't seem familiar or obvi-
ous, you can refer to the appendix to help you.
The appendix contains the creator codes for the
most popular programs on the Macintosh as
registered with Apple Developer Services or
discovered by Mac users.

NOTE: You can repeat steps 3 and 4 as many
times as you like. You can also close these
windows if things get too cluttered.

fliE===—===>=——— Info for Chapler | =r—=
File: |Ehﬂpter 1| | [JLocked
Type: Creator:
[JFile Locked [ Resources Locked File In Use: Yes
[J Printer Driver Multifinder Compatible File Protected: No
Created: |Sat, Oct 22, 1994 I Time: | 10:49:00 AM ]
Modified: |Thu, Dec 15, 1994 | Time:[12:51:13PM |
Size: 0 bytes in resource fork

64000 bytes in data fork
Finder Flags: @ 2.4 O 6.0.1

[]Has BNDL [CINo INITs Label:

[C1Shared Inited O Inuvisible
[ Stationery ] Alias [Juse Custom lcon

Figure 1-6. ResEdit’s file info window
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ResEdit won't always be helpful, because too often
developers forget the little detail of either assigning
their creator types to such documents or using a
generic creator like “ttxt” (which is Apple's own Teach-
Text program) because their Preference file or other
document can be read by TeachText. Ultimately, you
sometimes just can't figure out what application
hooks up to a particular document.

SUMMARY OF KEY TECHNIQUES

In this chapter, you learned the following useful tech-
niques for putting your Macintosh on a fitness plan:

P Selecting a folder or icon and using the Finder's
Get Info capability to find out how big it is (and
other data about it that will be useful later)

b Identifying potential orphaned documents by
their icons

P Using ResEdit to find out the creator of a
document



CHAPTER 2
CLEANING UP YOUR SYSTEM'S ACT

kay, people, time to clean house! In this chapter,
we'll get serious about this slimming-down
regime we're prescribing for our Macintosh systems.

A wise man once told me that when you have a job to
do, start with the hardest, nastiest, most obnoxious
part. When that’s done, the rest of the job will look like
a piece of cake. Candidly, that hasn't always worked all
that well for me, but it still seems like good advice. So
let’s start with the deep, dark mysterious recesses of
your System Folder. Once we're done with that, the rest
of the bloat your system has picked up over the years
will seem like child's play by comparison. Trust me.

In Chapter 1, we peeked inside the System Folder to get
a general idea of what's there. Now we're going to dig
more deeply into this Mystery of Mysteries and see how
many things we can find to toss into the proverbial bit
bucket. Along the way, we'll inevitably be drawn outside
the System Folder into application folders elsewhere
on your hard disk to look for systemlike documents and
objects that are candidates for removal.

PRELIMINARIES

To begin your workout, make sure you have a current
printout of the contents of your System Folder. You
created one of these in Exercise 3 in Chapter 1, but if



CLEANING UP YOUR SYsSTEM'S ACT

any significant amount of time has passed since you
did that, it's a good idea to produce a new one. As
we'll see shortly, strange objects have a way of appear-
ing in your System Folder when you're not looking.

At this point, you might well want to make a list of
the applications you use most often and where they
are located on your disk drive. Keep this list handy
throughout this chapter's workout. (You might also
want to browse the list of Macintosh applications in
the appendix. You might have overlooked something
that you use infrequently, but often enough that it
might prove important as you rummage around in the
System Folder attic.)

Since we're going to be looking at various document,
application, and system extension objects, it will be
helpful to be sure they are "in synch” with your hard
disk’s current state. For arcane reasons, your Macin-
tosh sometimes “forgets” what application is con-
nected to a particular document, for example. This
sometimes leads to the presence of the uninforma-
tive generic-document icon we learned about in
Chapter 1. To reduce the number of those lying
around in your System Folder as much as possible,
we're going to rebuild the Desktop on your Mac be-
fare we start our serious workout plan.

NOTE: Rebuilding your Desktop is a very safe
activity. In fact, Apple Computer support
personnel have been known to recommend
that you make it a practice to rebuild your
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Desktop every few weeks. But rebuilding
your Desktop has one unfortunate side
effect: All of the comments associated with
files are deleted when you rebuild your
Desktop. It's not likely that this is a big
deal, but if it is, you have two choices.
Either find a way to avoid losing the
comments or don't rebuild your Desktop.
This step isn't mandatory, but it will
probably make things a bit easier.

=5t EXERCISE 4—REBUILDING YOUR

DEsKTOP

. Start this exercise with your Macintosh

turned off.

. Turn your Macintosh on.

. Hold down the Command and Option keys as

your system starts up. Keep them held down
until you see a dialog box like the one shown
in Figure 2—-1.

Are you sure you want to rebuild the
desktop file on the disk “Diskoncerting”?
Comments in info windows will be lost.

(cancer] [ ox ]|

Figure 2-1. Dialog box for rebuilding Desktop
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4, Click on the OK button.

5. The system will rebuild your startup drive’s
Desktop. If you have other hard disks available
at the time you perform this exercise, you'll be
asked in turn whether you want to rebuild their
Desktops as well. It's probably not necessary,
but it doesn’t hurt anything, either. You can
decide. (Isn’t that charitable of me?)

With your Desktop rebuilt, your system now knows as
much as it can about what documents or files go with
what applications. That will take some of the guess-
work out of the rest of our workout.

In the interest of being as cautious as possible, let’s
take one more step and put into effect the Extra-Safe
Way Out. Create a folder in your System Folder and
name it something like Toss Out 7/1/95 or something
similar. (Note: You can put two spaces in front of the
folder name so that it will appear at or near the top of
the alphabetical listing of System Folder contents.
You don't have to follow that convention, of course.)
If you have any hesitation about whether throwing
away a particular object is going to be safe, you can
put that object into this folder. That way, if you dis-
cover later that you wish you hadn't thrown it away, it
will still be there. (Of course, you did remember to
back it up before all of this fun started, didn’t you?)
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Be sure to clean out this folder, though. It's probably
safe to assume that if you haven't used a document in
a few weeks, you probably don't need it.

NOTE: Another way of giving yourself this extra
protection is with a shareware program
called TrashMan. This handy little utility
automates Trash emptying and allows you
to decide how long files should be held in
the Trash before being deleted. This
program is on the Dr. Dan's Macintosh
System Fitness Plan disk yvou can order
using the coupon at the back of this book.

FINDING FILES

If you're using System 6, you have probably used the
Find File desk accessory Apple includes with the sys-
tem. Find File is a marginally useful tool that
searches a specific disk for a specific text string.

With System 7, Apple decided that a program called
the Finder ought to do at least a little intelligent find-
ing, so it improved the capability considerably. Sys-
tem 7.5 adds even further capabilities.

To find a file under System 7, just select the Find op-
tion from the File menu in the Finder. The result will
be a dialog like the one in Figure 2-2 under System
7.5. The dialog in System 7.1 is less attractive but
functionally nearly identical.
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Eﬂ% Find File ==————
Flnd ltamsl on all disks

: | name v | Lconiains

More I:natces

F|gure 2-2. Find Flle dlalog, System 7.5 edmon

You can select which disks or locations to search,
which field to search, and whether to look for files
that start with, end with, contain, or otherwise match
or don't match the criteria you provide. The More
Choices button expands the dialog in System 7.5 and
opens a new one in System 7.1. Both provide you with
some additional ways to conduct searches.

If you find the functionality of the built-in Find opera-
tions too limited, you can purchase a commercial
Desk Accessory with more capability. Two of the best
are Alki Seek, from Alki Software Corp., and Fast Find,
from Symantec Corp.

THE OUTER LiMITS

Begin your System Folder trimming exercises by fo-
cusing just on the objects that appear at its top level,
that is, not inside other folders. There shouldn’t be a
lot of items at this level; if there are, they probably
need some organization. But that's beyond the scope
of this book. (I promised to get your system slim and
trim, not organized, after all.)
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NOTE: If you're using System 6, your System
Folder's organization is radically different
from what I'll be describing, Most of the
documents and other objects I'll describe
here are stored either at the top level of the
System Folder or, in most cases, in the
System icon itself. The principles regarding
what to consider eliminating are valid, but
finding the objects won't be the same. I'll
note where there are differences that [ can
predict, but on some level, you'll have to
use this chapter as a general guide to
dealing with System Bloat in System 6.

Look at each item that isn't in a folder. Apply to each
item Equipment Rule 1.

‘.= EQUIPMENT RULE 1—ANALYZING
. OBJECTS

Apply this process any time you are evaluating an ob-
ject to determine whether it should stay on your disk.

Phase One: Identification
1. Do you recognize its icon or its name? If so,

move to the next phase, Deciding What to Do
with It
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2. If you don't recognize its icon or its name, use

Get Info. Sometimes even a generic-document
icon will reveal the originating application,
even after you've rebuilt your Desktop.

. If Get Info is no help, use ResEdit as described
briefly in Chapter | to find out its creator [D
and use this information to attempt to identify
the object from the appendix or other
resources.

. If can't identify the object, use the Extra-Safe
Way Out folder rather than tossing it directly
into Trash.

Phase Two: Deciding What to Do with It

Having identified the object, decide what to do with
it, using this process:

1. Ask yourself if it belongs with an application

you use often or need to keep around even for
occasional use. (If you answer yes, you can stop
evaluating this one; it's a keeper.)

2. Are you sure you don't need it? (Toss it.)

3. If you're not sure, use the Extra-Safe Way Out

folder rather than tossing it directly into Trash.
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TIP: As you go through the System Folder workout
in this chapter, you might find it helpful to
keep the printout of the folder that you
created at the outset close at hand. You can
then mark off each object as you look at it.
Particularly if you break this workout into
smaller sessions, this will prove quite helpful.

PRODUCT-SPECIFIC FOLDERS

After you've sifted through the top-level documents
and objects in your System Folder, it's time to do
some drilling. You could take the folders in alphabeti-
cal order, but it turns out that there are some patterns
of folder types that have some things in common. As a
result, working through the folders in a more logical
sequence pays some benefits in efficiency.

Start with the product-specific folders. These folders
usually bear names that reveal the application to
which they are related: Aladdin, Claris, Eudora, XTND
(Claris technology), GlobalFax, and the like.

You'll find that some of these folders have other fold-
ers nested inside of them. Treat these nested folders
just like the product-specific folders themselves.

WHAT You SHouLb Look For

Several kinds of files that are good candidates for
removal are often found in product-specific folders.
The most common kinds are:
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P Tutorial and sample documents

P Templates to be used to create specific
document types

P Translators and converters

P Telecommunication program modem drivers
(CCLs)

We'll take a look at each of these types of documents,
sometimes grouping similar types together for dis-
cussion purposes.

Tutorials, Samples, and Templates

Software publishers have not been consistent in
placing tutorial, sample, and template (stationery)
documents in the System Folder. Sometimes they
place such folders in the application folders directly.
The principles set forth in this section are valid re-
gardless of where you ferret out these often unnec-
essary files, however helpful they might be
temporarily or to a user with a different set of needs
and interests.

Ot=—0

L]

EXERCISE 5—SEARCHING OuT
11 TUTORIAL FILES

Some applications include tutorial documents and
lesson materials that are useful when you are learn-
ing them but that are largely uninteresting after
you've mastered the product. Unfortunately, these
files are often quite large because they include lots of
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detailed instructions, varieties of objects with which
to work, and so forth, Let’s see if there are any files of
this type in your project-specific folders.

1. Open a product-specific folder so you can see
the folders and documents it contains.

2. Scan through the names of the folders for such
words as Tutorial, Introductory, and Learning. If
you spot any such folders or documents, inves-
tigate their contents and decide whether you
think you will be likely to need them. If not,
these are great candidates for elimination. (As-
suming you know where the original diskettes
are, you can safely toss these documents and
folders, since the application won't depend on
their being around.)

3. You can repeat the first two steps for objects
that are not exactly tutorials but that serve a
similar purpose. For example, some word pro-
cessing and spreadsheet programs include a
great many sample documents that are
designed to give you ideas and starting points
for creating your own documents. This is very
helpful, but if you're not likely ever to need to
create a construction cost estimate, having a
spreadsheet example or template file that
makes that task easier isn't really of much use.
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TIP: Many tutorial and sample documents are
either stored as stationery documents or are
locked so that you don't inadvertently change
them and erase their value. When you try to
throw these documents away, you may find
yourself being told that some items couldn't
be deleted because they were locked or in
use. Just hold down the Option key as you
empty the Trash, and this problem will
disappear. So will the files!

For example, if you have installed ClarisWorks you'll
find a folder called ClariswWorks Stationery, which has
the following documents:

p ABOUT Stationery

P Business Stationery

P Fax Cover Sheet

P Internal Memorandum

P Mail Merge Letter

P Name & Address-Standard

P Newsletter-WP

P Personal Stationery-Std.
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P Presentation-Outline
P To-Do-List-Outline

You can tell from the names of these documents
whether they will be useful templates for things you
might want to create. Il you never expect to be called
on to design and lay out a newsletter, you can certainly
toss that one, for example. These documents are typi-
cally about 40K in size; eliminating a half dozen of
them gains you a quarter of a megabyte of space.

Translators

Many programs provide you with a number of files
whose purpose is to help you import files created
using other tools. There can be a staggering array of
these file translators. The chances that you'll actually
use more than a small handful of them are pretty slim
unless you're in an unusual business such as publish-
ing, where you have 1o be ready to accept files from
word processors to which stubborn writers cling long
after improved products have become available.

(Don't misunderstand. It is admirable that these pub-
lishers make such translators avzilable. For several
years after the Macintosh appeared on the market,
converting documents between applications—even
those that ran on the Macintosh, let alone between
Microsoft Windows and the Macintosh—was painful
if not impossible. But you are in a better position to
decide which, if any, translators you actually need
occupying space on your disk.)
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Deciding which translators or converters to keep
requires a little thought. Here's an exercise that can
result in gaining better control of this aspect of
your system.

O
I|

1

Sl
*) EXERCISE 6—UNCOVERING
TRANSLATORS AND CONVERTERS

. Refer to your list of the applications you use

frequently. Ask yourself how often, if at all, you
need to translate whole documents from one
application’s format to another. (Remember
that you can often copy and paste small
amounts of information between programs.
Remember, too, that if the applications sup-
port Publish-and-Subscribe (System 7.x or
later), you often don't need to handle any spe-
cific document conversion outside that
process.)

. Now make a list of any applications your col-

leagues, customers, and others use and from
which you have to translate documents.

. Consider the question of whether you need

two-way compatibility or whether you typically
need only to import or export specific docu-
ment formats.

. Armed with this information, locate the con-

verter or translator files within your product-
specific folders. They are typically pretty clearly
named to reflect their capability. Any that you
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find that you aren't fairly certain you need are
candidates for the junk food pile.

These files are often 60-128K in size, so finding a few
unnecessary examples of translators or converters
can result in picking up a megabyte fairly quickly. The
Claris Translators file installed with ClarisWorks 2.1,
for example, has thirty-three translators that occupy a
total of 813K on your disk.

NOTE: If you find yourself doing frequent
translations involving a variety of file
formats, you might want to consider
purchasing a product designed to handle
such a task. For example, LapLink, from
Traveling Software, offers dozens of file
format compatibilities between
Macintoshes and across Windows-
Macintosh links. These are often not only
more efficient and effective translators
than those that come with word
processors, spreadsheets, databases, and
telecommunications programs, but also
often take up less disk space. These
specialized programs often have custom
installation routines that let you select
only those translators you really need.
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Modem Drivers

If you have any telecommunications programs or in-
tegrated packages that include such products (for
example, ClarisWorks or Microsoft Works), there is at
least a chance that you have a veritable gold mine of
opportunity for shedding excess system weight. These
programs typically install modem drivers (known as
CCLs) in sometimes staggering numbers.

Unless you plan to change modems in the near future
without changing terminal software, you probably
don’t need more than one of the CCLs in your System
Folder. Assuming, of course, that your telecommuni-
cations program is working well with your present
hardware, you can simply identify which CCL you're
using and delete all of the others. Don't forget that
you may be using the program with more than one
modem if you have a PowerBook that you carry fre-
quently between home and office.

NOTE: Sometimes your telecommunications
program stores the CCLs it uses in its
application folder rather than in your
System Folder. That's how all of these
programs should behave. But Macintosh
programmers have learned that if they put
things into your System Folder, you're
much less likely even to see them, let alone
wonder about them and possibly even
(perish the thought) delete them.
Sometimes these concerns are legitimate.
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More often, though, they're just the safest,
easiest way for programmers to make
programs work the way they expect them
to work.

The first thing you have to do is find where the tele-
communications program you are using keeps its
CCLs. This isn't always as straightforward as it seems.
Many telecom programs store their CCLs in your Sys-
tem Folder. Others keep them in their own folder,
perhaps in a folder that is logically named or perhaps
not. In fact, not all telecom programs even have CCL
files. The widely popular shareware program ZTerm,
for example, doesn't use the CCL approach at all.
Rather, it provides menus with which you can cus-
tomize the telecom interactions it holds with other
computers. It recognizes that you use only one
modem at a time and simply allows you to configure
it. The bad news is, configuring it isn't trivial if you
don't have at least a rudimentary working knowledge
of telecommunications terminology.

R EXERCISE 7—IDENTIFYING THE MODEM
Ui DRIVER YOu ARE UsING

1. Launch the telecommunications program you
are using.

2. Look for a menu option called something like
Modem Setup or Modem Options or just Setup.
The name may be some variation on this theme,
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so you may have to do a little digging. (Of
course if your program is like ZTerm and doesn't
use CCLs, this whole exercise is fruitless.)

3. In the dialog box displayed after you select the
appropriate menu entry, there is probably a
popup menu that lists all the modems this pro-
gram “knows” about (those that have CCLs de-
fined for it). Note the name of the driver that is
now selected (it's the one showing in the popup
before you select it). Write that name down for
later reference.

4. If your program doesn't have such a setup dia-
log or for some other reason you can't find the
name of the CCL the program uses with your
modem, you can use the technique in Exercise 8
for identifying the appropriate driver(s) to keep.

5. Quit your telecom program. (You may in fact
have to do this before you can delete any of the
CCLs associated with your program, because
the program may not allow you to delete those
files while it is running.)

There is no common terminology for what the folders
that hold CCLs are called, so finding where these
little beasties are stored is what programmers call a
“nontrivial task.” But there is a single shortcut that
will work in 99 percent of cases.
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= ’ T | EXERCISE 8—FINDING AND REMOVING
=1 Mobem CCL FILES

1. If you've already identified the CCL file(s) you
need to keep, skip to step 6.

2. From the Finder, choose the Find option under
the File menu.

3. Depending on what version of the system you
are using, use the appropriate technique to find
files whose names contain the word Hayes.

NOTE: D. C. Hayes was a pioneering company in
the modem business and for years
dominated the market for personal
computer—based telecommunications
devices. It became customary for all
modems to achieve “Hayes compatibility.”
As a result, it is virtually unheard of for any
file of CCLs not to include at least one
Hayes driver or a driver labeled something
like Hayes Compatible.

4. Use the result of this Find operation to locate the
folder(s) where CCLs are stored on your system.

5. Navigate to each of those folders in turn.
6. In each folder that contains CCLs, identify the

one (or more) associated with your modem
needs. Generally, this is easy because the CCLs
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have names that identify the modem(s) with
which they are designed to work. Be careful,
though, because there are two possible
“gotchas” here. First, there may be more than
one CCL for your modem if it needs a different
CCL for different speeds (baud rates) and pro-
tocols (for example, V.32 or V.42). Second, your
modem may not be supported by the software,
or your driver may not be the one installed for
the program for some reason. The next steps
address what to do in these situations; if they
don't apply to you, skip to step 8.

7. If there are multiple CCLs for your modem, you
can probably err on the side of safety and keep
them all. As | said earlier, they are pretty small,
so a few of them hanging around on your hard
disk isn't going to be a big problem. Just toss
the other drivers that are clearly not needed.

8. If in steps 2-4 you can't figure out with the Find
technique which CCL your program is using you
might try seeing if it's using a generic modem
driver, These drivers have names like Hayes

NOTE: | recommend keeping these generic-
sounding CCLs around. They can come in
handy in case your normal CCL fails to
work for some reason. You can sometimes
get your telecom program to work with one
of these generic routines until you can
figure out the problem.
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Basic, Hayes Compatible, or Generic Modem.
Scan for one of those in the folder with which
you're working.

9. Because these files are small but crucial and
because reinstalling them can sometimes be a
pain in the modemus maximus, I'd suggest you
put all of the drivers you suspect you don't
need but are not 100 percent sure about into
the Extra-Safe Way Out folder. Then launch your
program and be sure you can still connect.

Finding and removing the unused CCLs in your sys-
tem can pay big dividends for your Macintosh'’s fit-
ness, even though individually these files tend to be
small, almost always under 20K. The reason? There
are so many of them lying around. For example,
America OnLine, one of my favorite telecom hot
spots, stores all of its CCLs in a folder called Online
Files, which it stores in its own folder. There are
something on the order of 115 of these files, and their
combined Disk Bloat rating is a not inconsiderable
700K. Removing all but the one or two you need can
save you the equivalent of half a floppy of disk space
on your hard drive.

SCREEN SAVER IMAGES

If you have a screen saver like Berkeley Systems’ After
Dark installed on your system—and it's a safe bet
that you do, since the vast majority of Macintosh sys-
tems on desktops use these programs—you should
enjoy the benefits of this exercise.
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75 ExercisE 9—SHEDDING EXCESS
SCREEN SAVER MODULE WEIGHT

. Scan through your System Folder and look for

folders whose names indicate that they contain
screen saver files. Most screen savers store
their images in a folder in the System Folder. If
you don't see anything at the top level, check
out the Preferences, Extensions, and Control
Panels folders.

. When you locate this folder, open it.

. You'll probably be surprised at the number and

variety of modules stored in this folder. Some of
them are pretty large, too.

. If you're not sure what a particular image looks

like, you can launch the screen saver program
by double-clicking on its icon and then using its
preview or demo capabilities to look at the indi-
vidual images you want to examine.

. You'll almost certainly find at least a few im-

ages here that just don't appeal to you. You
might identify one or two that you've never
seen before that you think are really cool, too.

. Once you've identified all of these images that

you're unlikely ever to want to use on your sys-
tem, mercilessly herd them into the Trash can.
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Some GENERAL CLOSING ADVICE

When you are rummaging about in application-spe-
cific folders in the System Folder, keep your eyes
open and your curiosity detector turned on high. If
you see a document or a folder that you don’t think
sounds useful, explore it. Find out how big it is; that
will help you decide if it's worth spending any signifi-
cant amount of time figuring out what it is.

If you wind up terminally curious about something,
stick it into the Extra-Safe Way Out folder and then
run the application to see if there’s anything critical

in the folder. The worst that should happen is that the
program won't run. Then you'll know that the folder or
document is critical, and you can just put it back
where you got it. No harm done.

Remember, it's your system, not Microsoft's, not
Claris's, not America OnLine’s, not anyone's but
yours. Be bold!

SYSTEM-LEVEL FOLDERS

When you are working with all of the folders in your
System Folder that are not obviously related to a spe-
cific program, you need to be a bit more careful than
with application folders. Still, you can almost always
safely put items you suspect of causing Disk Bloat into
the Extra-Safe Way Out folder and then run for a while
to see if any dire consequences result. Usually you'll
know right away because the system won't run or
some common function will suddenly stop working.
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We'll start our exploration by poking around in some
folders that you're almost certainly going to find in
your System Folder because virtually every Macin-
tosh has them. Then we'll offer some general sug-
gestions and exercises that are less specific to
individual folders.

FonTs

Don't tell my wife I'm even suggesting that you remove
any fonts from your system. She believes that you can
never be too rich, too beautiful, or have too many
fonts. When she opens the Font menu in her version
of Microsoft Word, the menu takes about three min-
utes to open completely on her big screen. It's a sight
to behold.
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The fact is, unless you're a desktop publisher, a graph-
ics artist, or a kidnapper who needs a well-disguised
ransom note now and then, you almost certainly have
more fonts on your system than you're ever going to
use. And these things take up gobs of space; they are
among the biggest causes of Disk Bloat.

U@@ EXERCISE 10—FINDING AND REMOVING
I UNUSED FONTS

1. Before you can get rid of unneeded fonts, you
need to figure out where your system has
stashed them. Table 2—1 gives you the primary
places to look, depending on the version of the
system you are using.

TABLE 2-1. PossiBLE FONT LOCATIONS

SYSTEM ToP LEVEL Fonts INSTALLED
VERSION OF FOLDER FOLDER IN SYSTEM
6 v
b | v N
15 \ v V

2. Font files have four possible icons, two of which
are common and important to know. Fonts
sometimes appear in suitcases with the letter
“A" on them (see Figure 2-3). This suitcase ob-
ject can contain either TrueType fonts (which
you can think of as “smart” or “sophisticated”
fonts that know how to draw themselves on your
screen and printer smoothly) or bitmapped
fonts (also known as “screen fonts). The icon for
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a bitmapped or screen font is a document icon
with the letter “A” occupying most of the icon
(see Figure 2-3), The other font icons represent
a TrueType font and a Postscript font and are
less prevalent today (although Postscript fonts
are required if you run either Adobe Type Man-
ager or Adobe Acrobat).

) Zl

Courier GaramBol

Figure 2-3. Icons for fonts

3. If you lind one or more fonts you're pretty sure
you can do without, you'll need to be sure that
only the Finder is running before you try to re-
move them. If you forget to do this, the system
will remind you (System 7.x) with a dialog like
the one in Figure 2-4.

You cannot change items used by the

0 system while programs other than the
Finder are open. To make changes to this
folder or suitcase, first quit all open
application programs and desk
accessories.

Figure 2—4. Dialog response to attempting to delete
font with applications open

4., Don't delete the fonts named Chicago, Helvetica,
Monaco, New York, and Times, since these are
considered “base” fonts that are often used in
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documents provided by publishers of various
Macintosh programs to display instructions.
Chicago is a system font used in dialog boxes,
menus, and dozens of other places, for example.
Also, if you have changed the font used to dis-
play your document and folder names in the
Finder, don't remove the font you're using for
that purpose.Other than those restrictions, feel
free to toss any font that doesn’t seem like
you're likely to use it. (You did back up your sys-
tem before you started this, didn't you?)

TIP: Under System 7.x, you can double-click on a
font's icon and see what it looks like even if
you aren't using it in any program at the
moment. The dialog looks like Figure 2-5.

== Chitago s

=D point s
How razorback-jumping frogs can level siy
piqued gymnasts!

<12 POIRE -+
How razorback-jumping frogs
can level six pigued gymnasts!

BT o
How
razorback-jumping
frogs can level siu
pigued gymnasts!

Figure 2-5. Displaying a font from the Finder
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If you are using System 7, you may find a folder called
Fonts (Disabled) in your System Folder. If you find a
folder of that name and it has fonts in it, they've
probably been there long enough now that you've
been unaware of them and you can safely toss these.

Sounps

Sounds are less likely to proliferate on your disk, if
only because most programs you buy don’t have any
sounds associated with them. (As multimedia gains
prominence, however, this situation is bound to
change.) On the other hand, some sound files are
huge, so finding them and removing unnecessary
noises and sound effects can pay big dividends as
you pump up your lean, mean Mac machine.

Sound files, whose icon looks like a speaker (see
Figure 2-6), are usually stored directly in the system
itself. Any sound you want to use as the system'’s
“beep” sound must be stored in the system. Sounds
used by other programs are usually stored in the
specific application folders.

Figure 2-6. Sound file icon

L=y —iu‘?fi EXERCISE 11—FINDING AND REMOVING
71T UNWANTED SOUNDS

1. Close all applications, control panels, and desk
accessories, leaving only the Finder open.
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2. Find the suitcase-shaped icon named System in
your System Folder.

3. Double-click on that icon. The result should
look something like Figure 2-7. As you can see,
the Finder holds primarily fonts and sounds.

System —=———=MNc|

10 items 1227 MBindisk  38.2 B avai
[t Name ) Size La
[©] oreplet 2k |3
[@ wdige 8K
(A rrexes 7*
(4 mreraiz 2
(4 r7extrazs K
@ MT Extra 48 oK
@ Quack 2K
@ Soesumi 2K
IE] Us. - System s 2K
“ild Eep 2% [}
s o R BE

Figure 2-7. Inside the System icon

NOTE: The System icon in System 6 holds much
more than sounds and fonts. In System 6,
most of the extensions you made to the
system were stored in this icon. Also,
under System 6 you cannot double-click on
the icon System and open it. Instead, you
must use Font/DA Mover, a program Apple
Computer supplied with your system to
relocate any item stored in the system.

4. Identify sounds that you don't intend to use as
system sounds.
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5. Move these sounds either to the Trash or to
your Extra-Safe Way Out folder.

6. After you've cleaned up the sound act in your
system, you can safely restart applications you
may have had to quit to start this exercise.

PRINTERS PROLIFERATE

How many times have you opened the Chooser (see
Figure 2-8) and wondered how in the world you
ended up with icons representing every printer known
to MacLand? But then you just select the printer you
need to get that report out by 5:00 p.M. and forget
about going back later to see what is going on here.

Laser'friter 300 Laser'writer 8

=
———— ==

LYW Select 310 Pvrsunil.‘.YrilerSC AppleTalk @ Active

O Inactive 75

Figure 2-8. Chooser for Printers

Let's do another little exercise to tighten up the sys-
tem's fithess on the printer front.
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Cls

7 ExerciSE 12—REMOVING UNUSED
T PRINTERS

1. Open the Extensions folder in your System
Folder. This is where printer drivers are stored
under System 7. (If you're using System 6 you'll
find them at the top level of the System Folder.)

2. Identily the printer(s) you use with this system.
3. Scroll through the Extensions folder and select
all of the printers you don't use, don't expect
to buy, never heard of, and can’t imagine why

they exist.

4 Toss those printers into the old Trash can.

SysTeEM CAPABILITIES YOU'LL NEVER USE

When a system is installed on your Macintosh, a fairly
significant number of files you'll almost certainly
never use get put into your System Folder. If you're
like most Macintosh users, you've never wanted to
move these files for fear of breaking something.

Most of these “goodies” end up in the Extensions
folder or the Control Panels folder. Open those fold-
ers and see if anything sounds like something you're
not likely to find a use for. Here are some of my per-
sonal favorites, but don't let this list be limiting:

P Easy Access. This extension makes your system
easier to use if you have a physical challenge.
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Apple should be applauded heartily for includ-
ing this kind of capability in the system. And if
you're using these features, by all means leave
them in place. But if you don't need them, you
can safely toss this little item.

» Voice Record. Some people love playing around
with recording their own voices on their Macin-
toshes. I have a friend who has used his own
voice and a popular shareware program called
Sound Manager to modify his system so that
warning messages and alert notifications all
come out sounding like him talking to himself.
Public rumor to the contrary, I'm not particu-
larly enamored of my own voice. | tossed this
162K Disk Bloater thirty seconds after | ran
across it.

P PowerBook. If you're on a desktop machine, this
goodie is about as useless a device as you're
likely to run across.

In general, my advice here is the same as you've
heard before. If you run across something that
sounds vaguely useless or uninteresting, stuff it into
your Extra-Safe Way Out folder for a few days or
weeks to see if anything untoward happens. If not,
pitch that item. You can always go back and recover it
with a custom installation of your system software.

DisABLED ITEMS

The longer you've been using your Macintosh, the
more likely it is that you'll find two folders in your
System Folder that bear a strong resemblance to the
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old Fibber McGee's closet of 1930s radio fame.
These folders are Extensions (Disabled) and Control
Panels (Disabled).

How do items get into these folders? Most of the
time, you put them there. Sometimes you do it know-
ingly, and other times you are just answering a ques-
tion posed by some program and it takes care of the
messy work for you.

If you haven't even looked into these folders in the
past few months, you're almost certainly safe simply
to open them up and shake their moldy, dusty con-
tents directly into the Trash bin. After all, if you
haven't needed them in so long you've forgotten what
they are, you probably don't need them.

Since these objects are already in a disabled state, it
isn't necessary for you to put them into your Extra-
Safe Way Out folder; if you're done with them, toss
them. No sense cluttering up the old Mac system
waistline with really empty calories.

ELIMINATING DuUPLICATE FILES

Duplicate files can end up in your System Folder—
and elsewhere on your hard disk—in a number of
different ways. For example, you might install a pro-
gram and then later either install the same version
inadvertently into a different folder or install a full
upgrade without deleting the original. Another way
you can wind up with duplicate files results from the
fact that some programs assume that you don’t have
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some requisite file and install their own copies or
versions of files that already exist as a result of other
program installations you undertook earlier.

Programs that involve the Apple Comm Toolbox
seem to have a nasty tendency to proliferate. One of
my hard disks had three sets of several of these tools
when | started writing this book. With the Informa-
tion Super Cowpath...er, Highway...looming on your
personal horizon, these files are going to be worth
checking on!

However they occur, duplicate files obviously waste
disk space. But before you run off and find all the
duplicate files on your hard drive and blow them into
the bit bucket, there is one major consideration to
take into account.

Some programs expect to find certain files in certain
places. Even though you might have two copies of the
same file in your System Folder, the programs that
may use these files may need to look for them in dif-
ferent places. So the mere fact of their duplication
isn't sufficient grounds for excising them from your
System Folder's life.

This is a clear case for the use of the Extra-Safe Way
Out folder. Before permanently disposing of the files
you will want to identify the programs that use the
duplicated files, put apparently unneeded copies of
the files into the safety folder, and then run the appli-
cations in question to be sure they still run correctly.
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FINDING THE DUPLICATES

One way to find duplicate files is to use the printout
of the System Folder's contents you prepared as part
of the preliminaries for this chapter. You can probably
spot duplicate files there just by scanning the list
repeatedly.

When you find duplicate files, mark them (using color
highlighters is helpful in this process). Then you can
go to your Macintosh and start determining which, if
any, of these files are actually identical twins and
which are different versions of a file.

NOTE: You have to be a little careful here. It
would not be unheard of, for example, for
you to find three documents with the word
Dictionary in their names. Yet all might be
completely different dictionaries, used by
different applications. Removing one or
two of these seemingly duplicated files
prematurely could cause the spelling
function in your favorite word processor or
desktop presentation package to refuse to
work next time you try it. Such fake
duplicates will almost certainly have
different icons.

Besides a visual scan of the printout of the System
Folder's contents, you can use more automated tech-
niques for identifying duplicate files in System 7.
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(The Finder in System 6 lacked a true “find" capability,
so this support isn't available if you're running on
System 6.)

[ J“l ']Tﬂ | EXERCISE 13—LOCATING DUPLIGATE
. FILES

1. Come up with a file name (or partial name) for
which you want to search for duplicates. You
might do this intuitively. “Hmmm. | wonder if
there aren’t a lot of copies of this Apple Modem
Tool lying around in some of my telecom pro-
grams,” you might think. Or you might think you
remember seeing two files with at least similar
names. If you have a bunch of free time on your
hands, you can even just pick file names from
the System Folder in some kind of sequence
and check for any or all of them.

2. From the Finder's File menu, choose the
Find option.

3. Enter the name or partial name you want to
search for.

4. If you're using System 7.1, click on More
Choices and then on the All At Once checkbox
in the second Find dialog (see Figure 2-9).

Under System 7.5, you don't need to expand the
choices offered in the first Find dialog.
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Find and selecl items whose

[ name ¥ | [ contains ¥ | [Apple Modem |
search [ on “Diskoncerti... ¥ | all at once

Fewer Choices [ cancer [ Fina |

Figure 2-9. Second Find dialog in System 7.1

5. Click on the Find button or press Return.

6. The system will locate all files on all mounted
hard disks that match the criterion you sup-
plied. Under System 7.5, it will list them in the
order it locates them in the top pane of the
Find dialog (see Figure 2-10). You can find out

Narne Size Kind Last Modified
L3 mIT project - folder 12/7/94 6:38 PM
[ LCR Project 8K Eudora docurmnent a4/14/94 6:10 PM
[ LCR Project.too 8K Eudora document a/14/94 6:10 PM
3 MDEF project - folder 12/7/94  638PM [
3 Mini-application project - folder 12/7/94 6:38 PM ‘[“l
B EES 301K HyperCard document 8/7/93 1049 PM [§]

@ HyperCard |
3 Double-X™ 1.0
B2 Examples {

D MiniEdit Project

Found 124 Items |

Figure 2-10. Found files dialog in System 7.5

where each is located by clicking on its entry in
the top list. Under System 7.1, after the search
is complete (assuming, of course, that you

asked the system to find all of the occurrences
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at once), all of the documents that match the
criterion are highlighted, and the first one is
scrolled into view. You can then scroll around
to find the other documents.

7. You can now look at each of the duplicated
entries and, following the advice above, deter-
mine which are candidates for removal from
your hard drive.

NOTE: System 7.5 Users Only: If you find
duplicated files and discover that two or
more programs need to use the same
program but expect to find it in different
places, you can take advantage of the
ability to create aliases for files. Just create
an alias of one of the files and then replace
all of the other files with the alias. You can
then delete the duplicated files, and the
applications will work fine.

WHERE YOU ARE

Now you've really started to hit your stride. You've
really cleaned up your System Folder. If you're typical
of most Mac users I've run into, you've probably
picked up several megabytes of badly needed disk
space by now.
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In Chapter 3, we'll tackle the rest of the disk outside
your System Folder with the same ruthless
vengeance with which we just whittled your System
Folder down to a more manageable—and sleeker,
more efficient—size.




CHAPTER 3

SLIMMING DOWN THE REST
OF YOUR Disk

hew! Aren’t you glad you have the messiest

part of this System Fitness Plan behind you?
Delving into the System Folder and its mysteries
should have emboldened you so that you are now
ready to try anything.

In this chapter, we'll take a look at some simple exer-
cises you can do involving folders other than the Sys-
tem Folder. Then we'll look at the issue of whether
programs that double the amount of space available
on your hard disk work well and how you might want
to use them. Finally, we'll discuss a disk optimization
technique called “defragmentation,” which is some-
thing like converting fat to muscle instead of elimi-
nating it completely.

VARIETIES OF Disk BLOAT

Let’s start with a little background. Many different
kinds of files are candidates for the Disk Bloat reject
pile. Here are some of the main kinds of files you
might want to delete from your system:

» Those you never needed but didn't know
were there

P Those you needed at one time but probably
don’t need now
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P Those you haven't touched since your Aunt
Tillie got married three years ago and aren’t
likely to touch until her children are in college

P Those for which you have an infrequent need
and that are taking up so much room that they
ought to become less permanent residents

Files in the first two categories are clear candidates for
removal. Those in the last two categories should prob-
ably be archived and then deleted. We'll talk about
archiving files when we consider these types of files.

STUFF You Never NEEDED OR DoN'T NEED Now

If you're like most Macintosh owners, you've probably
almost always installed new software using each par-
ticular program's easiest (or sometimes even “recom-
mended”) installation process. Although 90 percent
of Macintosh programs allow you to choose what is
generally called a “custom” installation rather than
the standard, default installation, you probably don't
use that option.

After all, if the manufacturer of the software has gone
to the trouble of designing a complete installation
program, why should you tinker with it? Simple. It's
your hard disk, not theirs! They couldn’t care less how
much stuff you end up with on your disk drive as a
result of their installation. They set up installation
processes that will cause them the minimal number
of headaches and calls for technical support. In the
process, they often put unneeded files into their ap-
plication folders or into various places in the System
Folder. Chapters 1 and 2 dealt with the system-level
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stuff. Let's turn our attention now to the kinds of files
that might be lying around your hard disk as a result
of full installations of programs.

Many programs install sample, tutorial, or demon-
stration files as part of their installation process. If
you've been using the program for a while, you prob-
ably no longer need these files (assuming, of course,
that you ever did need them). Let's see how many of
these folders and files we can remove from your
hard disk.

L35 Exercise 14—REMOVING SAMPLES,
It TUTORIALS, AND DEMONSTRATIONS

1. Repeat Exercise 5, this time concentrating on
the folders outside your System Folder. As in
Exercise 5, you can probably safely immediately
delete these files rather than put them into a
holding folder temporarily, since their purpose
is clear and no longer appropriate.

2. Now repeat Exercise 5 on the folders outside
your System Folder, but this time scan through
the folder names for such terms as Demo, Sam-
ple, Example, and Tour. Immediately delete any
that you clearly don't need.
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NOTE: You may want to take the time to scan a
printed directory listing of one or more of
your application folders that you suspect of
containing this type of file. | obviously can’t
come up with all the possible names
software publishers might use to denote a
file whose purpose is transitory.

3. Run Exercise 5 one more time, this time looking
for a folder name containing the word Template.
You'll find that some programs (notably word
processors, desktop publishers, and desktop
presentation packages) supply you with a
sometimes staggering array of templates to use
as a starting point for your own projects. Look
these over carefully and critically. Do you ever
expect, for example, to need to prepare a three-
column newsletter? Or a black-and-white Power-
Point presentation? Toss those that sound

NOTE: Templates are sometimes stationery
documents under System 7. Stationery
documents are often treated by their owning
applications as if they were locked, but they
are not necessarily locked in the Finder.
Remember that you can use the Option key
to force the Trash to empty even if one or
more objects it contains are locked.
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unpromising, particularly those connected with
programs you use fairly frequently and for which
you've never needed a particular template.

Another category of files that you probably don't know
exists are temporary files created by applications as a
safeguard against losing data. Sometimes these files
are created in a folder stored in the System Folder, but
often they are created in the application folder.

Most programs are pretty good about cleaning up
after themselves. If they create temporary files while
they are running, they delete those files automatically
when you exit normally. The operative word here,
however, is “normally.” If your system crashes or
power goes out while you're in the middle of a ses-
sion, the applications that are running at the time
never have a chance to do the proper cleanup. As a
result, you can end up with a proliferation of these
temporary files. Many of them take up little space,
but I've seen Word temporary files as big as 500K!
Fortunately, naming conventions make it fairly easy to
locate and delete these temporary files.

Ei=—3Y ExerciSE 15—REMOVING TEMPORARY
T FILES

1. Make sure you're not running any applications.
Some programs create temporary files while
they are running, if you try to delete them,
you'll just get frustrated.
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2. Repeat Exercise 5 on your application folders
(at least on those that create documents) and
your document folders (where you store docu-
ments created by applications that create
them). You can probably safely skip telecom-
munications program folders and games, which
seldom create documents, let alone backups of
documents. Here are the key search terms:

P Temp

P Tmp

P Bak

P Backup
b Copy

P ~ (tilde)

NOTE: In case you are terminally curious, the
origin of the search term Bak goes back to
the days of early computers running the
CP/M operating system. These systems had
what we old-timers sometimes call 8.3
(pronounced “eight dot three”) naming
conventions. The first part of the file name
was limited to eight characters, then a
period, followed by the last three
characters. Backup files created by almost
all programs on such systems were labeled
with the Bak three-letter extension.
Incidentally, this is the same naming
convention followed in MS-DOS (including
Microsoft Windows) and PC-DOS. Aren't
you glad you're a Macintosh user with file
names of thirty-two characters?
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STALE AND SELDOM-USED DOCUMENTS

One of the most fruitful areas to search for items to
remove from your hard disk is in documents that you
created and have since forgotten about. You may or
may not feel a need to keep such documents around
somewhere, but unless you generally work on pro-
jects that span long periods of time, it's probably all
right to keep such files archived where you can re-
trieve them when you need them.

ARCHIVING FILES

Now we'll turn to the topic of archiving files. Then
we'll discuss some alternative ways of identifying
documents that are candidates for this treatment and
how to use archive-and-delete techniques to free up
even more Disk Bloat.

ARCHIVING TECHNIQUES

It is probably clear by now that there are two cate-
gories of documents on your hard disk: things you put
there and things put there by programs you install or
use. ltems in the first category are safer to delete,
because you almost certainly can restore them fairly
easily from the disks on which they were originally
delivered to you. But before you delete a document
you created or obtained from another user, you might
well want to make a backup copy of it for safekeeping.

This process of making a backup of a file and then
removing it is sometimes called archiving a file. The
only trick is remembering where you stored the
archive if you need it again after deleting the original
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document. You may well want to compress the file as
you archive it so that it takes up less space on the
floppy disk or other medium on which you store it.

You can archive a file to a number of locations. Here
are the most common:

P One or more floppy disks or other
“removable media”

P Another hard disk on the same system
P A network server disk

P An on-line electronic mail or bulletin
board service

Whichever of these locations you choose, the basic
technique for archiving files remains the same,
as follows: '

1. Copy the file to the storage location, optionally
compressing it in the process.

2. Delete the original.

3. Make a record of where the copy is stored (see
Exercise 16).

How you retrieve the archived file when you need it
later depends on how you archive it, as you will
soon see.
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Whether to compress your files as you archive them is
mostly a matter of individual choice. Compressed
files take up less space, but when it comes time to
retrieve them, you will have to take the time to de-
compress (expand) them. If a file is too big to fit on a
single floppy disk, you will have to segment it; the
capability of doing this is generally part of a compres-
sion utility, so you will always have to use a compres-
sion program if you need to segment a file.

FILE-COMPRESSION OPTIONS

Two primary programs are available on the Macintosh
for file compression and expansion: Stuffit (which
comes in a variety of flavors and versions) and Com-
pact Pro. Which program you use is primarily a matter
of personal taste and choice. | prefer Compact Pro,
although I use both of these utilities from time to
time. My preference is mostly historical, but Compact
Pro does seem to create slightly smaller archive files
than does Stufflt.

Both of these file-compression utilities can produce
two basic types of files: compressed and self-extract-
ing. A compressed file requires the original compres-
sion program to be available to decompress it. A
self-extracting archive, which is 10-18K larger than
the equivalent compressed file, carries along with it
the capability of expanding without the original pro-
grams being available. You probably don't need to
create self-extracting archives, since you will typically
be expanding the files yourself on the system on
which you compressed them.
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NOTE: If you create or download or otherwise
obtain self-extracting archives, you may find
them taking up a fair amount of space on
your hard disk. You can reduce them from
self-extracting archives to regular archives
with a nifty little freeware program called
DeSEA. One of the virtues of this program
is that it will work on multiple files without
restarting, so you can remove the excess
self-extracting code from a collection of
self-extracting archives very quickly.

By tradition, compressed files have a file extension
associated with them (much as the CP/M and MS-
DOS files | talked about earlier had three-character
extensions). A compressed archive created with
Stufflt, for example, has an extension of “sit”; one
created with Compact Pro has an extension of “cpt.”
Self-extracting archives usually have an extension of
“sea,” regardless of which program created them. If
you had a document called Extraordinary Ideas and
you compacted it, its file name would, by default,
become one of the following:

P Extraordinary Ideas.sit—if you used Stuffit to
compress it

P Extraordinary Ideas.cpt—if you used Compact
Pro to compress it

P Extraordinary Ideas.sea—if you created a self-
extracting archive using either product
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NOTE: Compact Pro is available only as
shareware. Stufflt Lite is the name of the
shareware version of the commercial
product Stuffit Deluxe. You can download
either or both of these programs from your
favorite on-line service.

TRACKING ARCHIVES

If you are a System 7 user, Apple Computer has pro-
vided you with a slick way of keeping track of where
your archive files are. If you're a System 6 user, you're
going to have to be a little more creative and do more
of the work yourself, but there are still a couple of
useful techniques for handling this task.

EQuiPMENT RULE 2—TRACKING
ARCHIVES ON SYSTEM 6

1. Locate a document you wish to archive (see
Exercise 16).

2. Copy it to its archival destination.
3. Delete it from your hard disk.

4. Create a TeachText document of the same name
as the archived document.

5. In the TeachText document, write the location
of the archive (for example Floppy disk named
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“Archives December 1994"). Now any time you
open the document, you'll be told exactly where
to find it.

: I; EQuIPMENT RULE 3—TRACKING
* ARCHIVES ON SYSTEM 7

. Locate a document you wish to archive (see
Exercise 16).

. Copy it to its archival destination.
. Delete it from your hard disk.

. Select the archived document in its archived
location.

. From the Finder’s File menu, choose
Make Alias.

. Copy the alias of the archived document to the
document’s original location on your hard disk.

. Don't forget to delete the alias of the document
from the archive location. When you double-
click on the alias on your hard disk, the system
will prompt you to insert or mount the disk or
server on which the archive is located.
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FINDING THE OLD STUFF
Now that we have some basic Equipment Rules for
dealing with the archives, how do we locate files that

are candidates to be archived?

You'll want to determine your own parameters, de-
pending on how you work, of course. According to the
set of rules that | use, | should consider archiving any

document that:
P hasn't been modified in sixty days and
P isn't part of a current project; or

b is larger than 100K and hasn’t been modified in
thirty days.

| don't always follow those rules, of course, but those
are my guidelines. Locating such documents on your
hard disk is pretty easy.

Uﬁ‘i—iﬁ‘-@ EXERCISE 16—LOCATING OLD FILES
I
1. In the Finder, open the windows and folders in
which you wish to search for old documents.

TIP: This is a place where it pays to open folders
on the Desktop rather than just expanding
their views in the Finder windows.
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2. From the Finder's View menu, choose By Date.

The files are now sorted so that the longer it's been
since you modified them, the lower in the window's
scrolling list they will appear.

TIP: In System 7, you can shortcut this menu
option by clicking on the label in the Finder
window corresponding to the order in which
you want to see the files listed. For example,
to sort them by their last-modified date, you
would just click on Last Modified in the
window's header area. Figure 3—1 shows a
folder's contents listed in name order. Figure
3-2 shows the same folder in contents order
by the date documents were last modified.

184.4 MB in disk 11.9MB available
- s TP e
® Chapter1 B3K Wed, Dec 7, 1994, 1:02 PM |
¥ Chapter2 112K Wed, Dac 7, 1994, 1:15 PM
¥ Chapter3 21K Mon, Dec 12, 1994, 4:33 PM
#  Chapter 4 Motes 4K Mon, Dec 12, 1894, 10:23 AM
W Delivery Note 127194 7K Wed, Dec 7, 1994, 1:03PM
W Preface 21K Mon, Dec 12, 1994, 11:00 AM
# Preface Notes 4K Tue, Dec 6, 1994, 1246 AM
¥ Proposal 127194 11K Wed, Dec 7, 1984, 1:30 PM
'a Research Questions 1217 4K Wed, Dec 7,1994, 1:37 AM |
(& [

Figure 3-1. Folder sorted by name
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11.9MB available

184.5 ME in disk
il Size LastModif :ﬂ—- B i

¥ Chapter3 21K Mon, Dec 12, 1994,4:33 PM ’Q

# Preface 21K Mon, Dec 12, 1994, 11:00 AM

¥ Chapler 4 Notes 4K Mon, Dec 12, 1994, 10:23 AM

) Proposal 927194 11K Wed, Dec 7,1994, 1:30 PM

# Chapter2 112K Wed, Dec 7, 1994, 1:15 PM

W Delivery Note 1217194 7K Wed, Dec 7, 1994, 1:03 PM

W Chapter 1 63K ‘Wed, Dec 7,1984, 1:02 PM

)  Research Questions 1217 4K Wed, Dec 7,194, 1:37 AM

W Preface Notes 4K Tue, Dec 6, 1994, 12:46 AM 5]
=l [

Figure 3-2. Folder sorted by last date modified

NOTE: Since applications don't typically get
modified by the user, you'll find that they
tend to fall to the bottom of the window
when you sort by the last-modified date.
That will come in handy as you'll soon see.

REMOVING APPLICATIONS

In some ways, removing applications is safer than
removing documents from your disk. After all, if you
delete a program that you later decide you shouldn’t
have deleted, you can always go back to the original
disks and reinstall it. A document you created,
though, is a different story: delete one without back-
ing it up or archiving it first, and you could find your-
self having to recreate work.
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There is one aspect of removing unneeded applica-
tions that you should consider carefully before
doing. You don’t want simply to delete the applica-
tion file (and, presumably, any supporting docu-
ments and files installed in its folder). You also want
to remove any vestiges of its existence from your
hard disk. In other words, you really want to uninstall
the application.

Unfortunately, the idea that you might ever want to
eradicate from your hard disk any recollection or rem-
nant of a program’s existence seldom occurs to the
people who write the programs. After all, they see the
program they create for you as a masterpiece that
you'll never want to do without again in your entire
computer life. Only recently has it become considered
necessary to include uninstall routines with software,
but most commercial programs (as well as virtually
all freeware and shareware titles) do not yet incorpo-
rate this capability.

As you remove an application from your hard disk,
then, you will want to revisit Chapter 2 and some of
the earlier exercises in this chapter to assist you in
removing other files related to the program you are
deleting. This applies particularly to the System
Folder, since (presumably, at least) any supporting
files installed with the program are either in the ap-
plication's folder or in the System Folder.

I recommend that you carry out Exercise 17 as a final
step after removing any program from your hard disk.
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257 Exercise 17—REMOVING ALL TRACES

I~ OF A PROGRAM

(You can do this exercise before removing the appli-
cation, but it is somewhat cleaner to do so after you
believe you've removed all of the program files. You

won't run into as many instances of the application’s
supporting cast this way.)

1. Repeat Exercise 5, focusing on your System
Folder. Provide the name of the application
(minus any version numbers) as the search
term. This will help you uncover Preferences
folder entries, startup documents, and folders
of supporting resources.

2. Having located any such objects, delete them.

There is another way to work with issues of installing
and uninstalling software. The disk called Dr. Dan'’s
Macintosh Fitness Plan Disk, which you can order by
using the form at the back of this book, includes
software that will help you keep track of changes
made to your disk as a result of installing a program.
It generates a log file that you can later use to re-
cover from the installation if you decide to remove
the application.
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DouBLING YOUR Disk’s CAPACITY

Several commercial programs that have become
available in the past year or two effectively double
the amount of information you can store on your
hard disk. These seem like magic. (One of my all-time
favorite authors, Isaac Asimoyv, is credited with say-
ing, “Any reasonably interesting technology is indis-
tinguishable from magic.”) In practice, how well do
they work?

My experience with these programs, both on the Mac-
intosh and on other desktop platforms, has been uni-
formly good. The programs seem to work reliably, and
they clearly do increase disk capacity. They do their
work in the background, compressing files that have
been identified (by type, not by specific document or
object) as acceptable candidates only when your ma-
chine isn't working on something more important
(which is almost everything). Essentially, these pro-
grams compress data just like the programs | men-
tioned earlier for archiving purposes, but these
programs work automatically and in the background
rather than in the foreground and only on demand.

If you are running a reasonably fast machine, you
won't notice the slowdowns that take place when you
ask your system to open a particular document or
launch a specific program and that object has been
compressed. There is a delay (it would in fact be im-
possible for there to be no delay, since the decom-
pression clearly introduces a separate step in the
launch process), and on older, slower Macintoshes, it
can be not only noticeable but also annoying. So if
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you're still running an old SE/30 or Macintosh Il or llx,
you probably don’t want to use one of these
programs unless it is the last resort and then only
until you can afford a faster machine, a bigger hard
disk drive, or both.

But if you're running a newer Macintosh with a high-
speed CPU, you should definitely consider buying one
of the well-known programs for increasing disk capac-
ity. There are several on the market, and differences
among them seem to be largely cosmetic, from all I've
been able to gather. The best-known products in this
category are:

P Stufflt SpaceSaver
P AutoDoubler

P Stacker

P TimesTwo

(Actually, Stacker and TimesTwo aren't, strictly speak-
ing, compression programs. They have the same ef-
fect as the other programs in this category, but they
work differently. Don't worry about understanding
how they work, though.)

NOTE: You will probably hear scare stories about
people who have lost data—or even entire
hard drives of information—because of
these programs. | have never seen a
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documented case in which these programs
could be isolated as being at fault in such
situations. If you are careful about backing
up your data, you shouldn’t have any
concern about using these well-
established programs to give yourself
greater disk capacity.

You might think that if you use one of these programs,
you can ignore the rest of the advice in this book.
After all, if you can take your 250MB hard disk up

to 500MB (that's a half-gigabyte drive, where giga
means billion, just in case you want to impress all

of your guests at your next cocktail party), why
would you want to waste time putting it on a

fitness plan?

Wrong! There's a fundamental rule of the universe
that says, “Your need for anything will always expand
to absorb all of the available supply of that some-
thing, plus 10 percent.” That rule applies to disk dri-
ves as well. Trust me. | know.

WHERE YOu ARE

You've probably recovered several megabytes of Disk
Bloat by now. Your hard disk should be looking and
feeling pretty lean and mean.

In Chapter 4, we're going to do a few simple exer-
cises aimed at improving your system's performance
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through making more of its memory (RAM) available.
Although this activity is related only marginally to
Disk Bloat, it is nonetheless helpful. Any good Mac-
intosh needs all the RAM it can get!




CHAPTER 4

GIVING YOUR MEMORY SOME
ELBOW Roowm

his chapter focuses on making more effective use

of the memory (RAM) installed in your Macintosh.
Although it is true that short of physically plugging in
more RAM chips, you can't do a lot to increase your
Macintosh’s memory, there are a few exercises you
can do that will help you expand available RAM. You
can make more memory available by doing any or all
of the following (which we'll cover in greater detail in
the remainder of the chapter):

P Clear out unused or inefficient INITs that load
into memory every time you start your system

P Change the amount of memory allocated to
applications you use frequently

P Change your RAM disk and virtual memory
settings

P Buy software that “tricks” your Macintosh into
thinking it has more memory than it really does

SHEDDING UNSIGHTLY INITS

When your Macintosh starts up, does it seem to you
like there are about 100 little icons appearing on the
screen? Are you a victim of what has come to be
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known as “icon crawl”? If so, you might find yourself
running out of memory more often than you need to.

Most of the icons that appear across the bottom of
your screen as your Macintosh starts up are probably
familiar to you. You probably voluntarily agreed to
have most of them appear there, at some point or
another, whether or not you were aware of the conse-
quences of that decision at the time. Some of those
icons were put there by programs as you installed
them. (Actually, the icons themselves weren't put
there; the icons merely let you know that some sys-
tem extension is being loaded into memory.)

NOTE: Not all of the system extensions that are
occupying RAM in your Macintosh display
an icon to indicate that they are doing so.
Some such extensions don't have icons;
others allow you to turn their icons on and
off during startup, and you may have elected
at some point not to have them shown.

WHAT ARE THESE THINGS?

INITs are a category of system extension. System ex-
tensions, in turn, add functionality to your system
that isn’t part of the system software that is always
present. An INIT (the name is taken from the fact that
it is placed into your Macintosh’s memory when your
system is being INITialized each time it starts) adds
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some capability to your system. You've probably
come to rely on many of these programs. Most of
them are largely transparent.

Control panels are another category of system exten-
sion. This type of addition gives you the ability to
control certain aspects of your system by opening a
small window (see Figure 4—1 for an example) and
changing some settings that determine how your
system will behave. Some system extensions have
both an INIT and a control panel, but most come in
one form or the other.

E[J==== Mouse
Mouse Tracking
A 2
B £
O] eleleiCiele;

Very Slow Slow Fast

. o v o%e
m Double-Click Speed

Figure 4-1. Mouse control panel from System 7.x

How MucH Space Do THeY Occury?

A good place to start shedding excess RAM weight is
to find out how much of an impact these little critters
have on your system’s memory. To do that, you need
to start your Macintosh with no INITs or control pan-
els loaded. Doing that is easy under System 7 and not
so easy under System 6.
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) P—
St EXERCISE 18—DETERMINING IMPACT OF

-1 INITs AND CONTROL PANELS

System 7 Users
1. Shut down your Macintosh.

2. Start your Macintosh again, but hold down the
Shift key while it starts. Keep holding the Shift
key until you see a message that says “Exten-
sions Off.” Then you can release it.

3. After your system is fully “awake,” choose About
This Macintosh... from the Apple menu (it
should be the first item). You'll see a window
something like the one in Figure 4-2.

|
i

sS[J==————= About This Macintosh

System Software 7.1
e Macintosh SE/30 @ Apple Computer, Inc. 1983-1992

Built-in Memory : 8,192K Largest Unused Block: 9 870K
Total Memory : 12,288K  12,288K used as RAM on Diskoncerting

System Software  2,442¢ [N | (<

]

Figure 4-2. About This Macintosh window

4. Make a note of how much memory your system
has available.

5. Restart your system, this time letting the start-
up process continue as usual.
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6. Once the system is back in operation again,
check the amount of memory available.

7. By subtracting the memory available at step 6
from the amount in step 3, you'll be able to find
out how much memory the various system ex-
tensions your Macintosh uses occupy.

System 6 Users

1. From the Apple menu, choose About
The Finder.

2. Record the amount of RAM available in your
system now, with all of the extensions loaded
into memory.

3. Open your System Folder.

4. Create two new folders: Unused Control Panels
and Unused INITs.

NOTE: Unlike under System 7 System 6 INITs go
by a variety of names and types and are not
particularly easy to locate. This, in fact, is
one of the biggest improvements from
System 6 to System 7 from the standpoint
of managing your Macintosh life.

5. From the View menu in the Finder, choose By
Kind. This arranges your files by the type of file
they are rather than by name or date, as you are
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probably accustomed to viewing your files.
(Note that the files are arranged alphabetically
according to their type.)

6. Locate the Control Panel files. They will all be
together. Drag them to your newly created Un-
used Control Panels folder.

7. Look for documents that appear to be System
documents. (They have type names like System
Document and Chooser Document.) Locate as
many as you can and drag their icons into the
Unused INITs folder.

8. Restart your Macintosh.

9. After the system is operational again, check the
memory available, as you did in steps 1 and 2.

10. By subtracting the memory available at step 2
from the amount in step 8, you'll be able to find
out how much memory your Macintosh system
extensions occupy.

If you think you can gain enough advantage by re-
moving some of the system extensions you don't
need, continue with this section. If the results of
Exercise 18 indicate that your system doesn’t have
an excess of system extensions cluttering up mem-
ory, skip to the next section, “Reallocating Memory to
Applications.”
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FINDING AND REMOVING UNNEEDED EXTENSIONS

As was the case with other system documents you ran
across in Chapters 1 and 2, you will find that exten-
sions fall into three broad categories: those, like
printer drivers, that you recognize and can easily de-
termine whether you need: those, like INITs related to
programs you have long since removed, that you can
easily determine you don't need; and those about
which you haven't the foggiest notion.

By now, you don't need anyone to help you figure out
what to do with those INITs and Control Panels that
fit into either of the first two categories.

NOTE: Because the consequences of removing an
INIT that your system needs can be fairly
painful, | always recommend using the
intermediate-folder approach to removing
these items. You might create a folder called
Extensions (Disabled) and put all INITs in
there for several days or weeks before
moving them to the Trash. That folder is a
place where, unless you are absolutely
certain that removing an INIT won't cause a
problem, you're better off erring on the side
of caution.

Let’s see if | can help you figure out how to deal with
the INITs and control panels that are mysterious to
you. For each unknown extension, perform the steps
in Exercise 19 as needed.
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y ! EXERCISE 19—IDENTIFYING UNKNOWN

1 SYSTEM EXTENSIONS

Use ResEdit as explained in Chapter 1 to find
out what application created the INIT or is as-
sociated with it.

Compare the Extensions [older with the Control
Panels folder to see if a control panel is associ-
ated with the INIT. Because control panels have
user interfaces associated with them, they usu-
ally provide some identifying information that
will help you sort out their origin and purpose.

Most extensions (INITs) will not respond mean-
ingfully when double-clicked. Usually, the Finder
will simply tell you that they can’'t be opened.
Under System 7, the feedback is a bit more infor-
mative, but the net result is the same. Still, some
extensions do activate. For example, the exten-
sion SuperClock!, which is pretty common in the
Macintosh community, will open a window that
is vaguely reminiscent of a control panel when
it's double-clicked. So you might just try double-
clicking on a particularly stubborn and obtuse
extension. Just don’t get your hopes up too high!

When all else fails, put the questionable INIT into
a holding folder and then restart your system.
Use it in the normal way for a few days. If nothing
untoward happens, you can probably toss the
extension. (Don't forget to back up your System
Folder before doing such things, however.)
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It is not always necessary or advisable to remove an
extension or control panel from your system. Fortu-
nately, there is a somewhat safer way to deal with
unknown objects of this type. Apple Computer sup-
plies a control panel called Extensions Manager
that can be quite useful when vou are dealing with
system extensions. (Since Apple distributes this
product freely, I've included a copy of it on the Dr.
Dan's Macintosh Fitness Plan Disk that you can order
using the form at the back of this book.) Double-
clicking on it brings up a window something like the
one in Figure 4-3.

HJ== Eutensions Manager ==

Extensions Manager
by Ricardo Batista
Conflict Catcher™
Sigma™ Compression INIT
Apple® Event Manager
Butler Access
Caps Lock
ClickPaste INIT 2,243
Config PFP
CursorFixer
DAL
Desk¥riter 2.2
File Sharing Extension

((nort ) [ Anon | [ Revert ]

@1991 Appls Computer, Inc.
Apple Integrated Systems

Figure 4-3. Extensions Manager's window

The scrolling list in the Extensions Manager window
contains an entry for each extension in your system,
whether it is now active or not. Those that are active
are highlighted; those that are presently turned off are
not highlighted. You can select any extension in this
list and turn it on or off. Or you can turn all extensions
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on or all extensions off. Next time you restart your
system, extensions will be handled in accordance with
your instructions in this control panel.

Commercial products can provide this same function-
ality, with additional capabilities. One of the most
popular is NOW Utilities’ Startup Manager. With ei-
ther of these applications—or something similar—
you can selectively turn extensions on and off and
thus determine what you can safely throw away.

REALLOCATING MEMORY TO APPLICATIONS

Each application that you run on your Macintosh
occupies a certain amount of memory. The amount it
occupies is determined by the application developer,
but you can change the developer's decision. Some-
times you need to allocate more memory than the
developer thought (perhaps, for example, because
you are working with particularly large and complex
documents or graphics). Sometimes you'll find that
the developer anticipated users doing more complex
things with the program than you need.

Let's take a look at how to find out how much space is
being allocated to your program, how to find out how
much it's actually using, and how to adjust memory
allocation as appropriate.
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L= Exercise 20—FiNDING OuT How
T  MucH MEMORY IS ALLOCATED

1. Select an application icon in the Finder.
2. From the File menu, choose Get Info or press

Command-1. A window something like the one
in Figure 4-4 opens.

E[J=== FileMaker Pro Info =

FileMaker Pro

Kind : application program
Size: | MB on disk (1,125,414 bytes
used)
Where : Diskoncerting: FileMaker Pro 2.0 f:

Created: Fri, Jul 22, 1992, 1220 PM
Modified: Fri, Jul 22, 1994, 12:30 PM
Yersion: FileMaker Pro 2.1v3e
July 1994
Comments :

~Memory Requirements -
' Suggested size: 1200 K

| Minimum size:  [640
[ Locked i Preferredsiza: |1200 K

Figure 4-4. Typical Get Info window

3. Note the three numbers in the lower-right cor-
ner of this window. (If you are running System
6, you'll see only two numbers: one for the sug-
gested size and one for the preferred size. The
principles in this exercise are nonetheless use-
ful and valid.) Two of these numbers are ed-
itable, as indicated by the fact that they are
inside rectangles. We'll come back to editing
these values in Exercise 22,
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4. As you can see in Figure 4-4, FileMaker Pro on
my system is set up so that it prefers 1200K (or
1.2MB) of memory available but will open if as
little as 640K is available. For each application
whose memory allocalion you wish to examine,
make a note of these two values. The suggested
size is proposed by the developer.

When you launch an application, the system allocates
memory using roughly the following scheme:

1. If the amount of memory indicated as its Pre-
ferred size is available, it allocates that much
space.

2. If the amount of memory indicated as its Pre-
ferred size is not available, it looks at the Mini-
mum size. If that amount of memory is available,
it allocates that much space. If more than the
Minimum but less than the Preferred size is
available, it allocates all available memory.

3. If the Minimum size amount of memory isn't
available, the system refuses to launch the pro-
gram and notifies you that insufficient memory
is available. (Under System 7, it also suggests
ways to solve the problem. For example, if it
notices that an application is running with no
windows open, it might suggest closing that
program to free up memory.)
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Just because your system allocates a certain amount
of memory to an application doesn't mean that the
application is using all of the allocated space. When
releasing a program, the developer decides how much
space to request, based on testing, what typical users
will likely want to do, and so forth. Your mileage may
vary, so you may need or wish to “tweak” memory
allocation from time to time.

Under System 7 (if you're a System 6 user, you can
skip to the end of Exercise 21 now), you can find out
exactly how much space a program is using at any
moment. This is a little-known feature of System 7.

L= Exercise 21—FINDING OuT How
T MuUCH MEMORY A SYSTEM 7 PROGRAM
Is USING

1. Open one or more of your favorite applications.
If you like, open a document or two (or several)
so that you are in a typical usage situation with
each application.

2. Return to the Finder by selecting it from the
Application menu at the upper-right corner of
the screen.

3. From the Apple menu, choose About This Mac-
intosh. You'll see the expected window, with
each aclive application shown. Note that each
application has a bar graph associated with it.
The filled-in portion of this bar indicates what
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portion of the total allocated memory (repre-
sented by the entire bar) the application is
now using.

4. Now comes the neat part. From the Balloon
help menu just to the left of the Application
menu in the upper-right portion of your screen,
choose Show Balloons.

5. Now point at the bar associated with any active
program. A balloon appears telling you exactly
how much memory the program is allocated
and exactly how much it is now using.

6. Now compare the amount of space the applica-
tion is using with the amounts allocated and
minimum size you found in Exercise 20. Note
which applications have more space allocated
than you seem to need.

Once you've found a program that seems to have
more space available than it really needs for you, you
can free up memory by reallocating its space.

Dﬁl — 1 EXERCISE 22—REALLOCATING MEMORY
ITT  TO A PROGRAM

1. Select the program’s icon in the Finder.

2. From the File menu, choose Get Info or press
Command-1.
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3. In the resulting dialog box, change the preferred
size value to a more reasonable number, based
on your findings in Exercise 20 (if you're a Sys-
tem 7 user) or on your intuitive feeling about
how much program space you actually need (if
you're a System 6 user). You'll find that you can-
not set the Preferred size smaller than the Mini-
mum size. An attempt to do so produces a
dialog like the one shown in Figure 4-5.

The Minimum size can’t be larger than the
Preferred size.

Do you want to set the Preferred size to
the Suggested size of 950K?

[cancel] [ ok |

Figure 4-5. Notification of attempt to set
Preferred size too low

NOTE: | recommend that you never change the
Minimum size unless you find it absolutely
necessary. Nasty crashes can result from
setting this value too low.

CHANGING Disk CACHE AND VIRTUAL
MEMORY SETTINGS

Under both Systems 6 and 7, you can allocate space
to what is called a disk cache. Under System 7, you
can set up space on your hard disk to be treated as if
it were memory, a scheme called virtual memory. In
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this section, we'll take a look at these two capabilities
and how they affect RAM and disk space availability
on your system,

You CAN'T SPEND Disk CACHE

A disk cache is a portion of your computer's memory
that is set aside for the system Lo use. It uses this
area of memory in ways designed to accelerate perfor-
mance.

In the absence of such a cache, certain kinds of infor-
mation your programs use can be “purged” from mem-
ory while the program is running. (This process is
perfectly safe and an entirely appropriate design deci-
sion made by the developer of the program in ques-
tion. The information isn't lost; it is simply removed
from memory until needed again, generally to make
way for something the program considers more cur-
rently important or useful.) For example, if you are
using a word processor and you ask it to find a phrase
in your document, the program code and the dialog
box that assist in that process are both loaded into
your program's portion of the Macintosh's memory.
When the find operation completes, the word proces-
sor might decide it needs more space for more text or
a font change. In that case, it unloads, or purges, the
find-related objects from its memory space. These ob-
jects remain on your disk, of course, and can be easily
retrieved by the program when they are needed again.

A disk cache acts as a kind of halfway house for this
kind of information. If you have a disk cache turned
on (under System 7, it is always turned on) and it is
large enough to be helpful, the system routes purged
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objects to the disk cache area of memory rather than
simply removing them. The net effect is that if you
suddenly need one of the objects stored in the disk
cache portion of RAM, retrieving it is significantly
faster than reading it from your disk drive. Thus fre-
quently used items are more immediately available to
your program.

The problem, of course, is that the area of RAM set
aside as a disk cache isn’t accessible to your
programs for any use that the system doesn't intend.
If you have a large disk cache, you are depriving your
applications of space. Make the disk cache big
enough, and you may find yourself unable to load as
many programs as you'd like.

@j 7 EXERCISE 23—ADJUSTING YOUR Disk
171 CACHE ON SYSTEM 7

1. In your Control Panels folde